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Where to Find the Latest Information 

Keysight will periodically update product documentation. For the latest information about this 
wireless test set, including software upgrades, operating and application information, and product 
and accessory information, see the following URL:  
www.keysight.com/find/E7515A 

Is your product software up-to-date? 

Keysight will periodically release software updates to fix known defects and incorporate product 
enhancements. To search for software updates for your product, go to the Keysight Software 
Manager website at:  
www.keysight.com/find/softwaremanager 
 

  

iii 

http://www.keysight.com/find/E7515A
http://www.keysight.com/find/softwaremanager


 

This page is intentionally left blank. 
 
 
 
 
 
 
 
  
 

iv 
 



 

Table of Contents 

1 Introduction ................................................................................................................................................. 7 
Latest Documentation ..................................................................................................................... 7 
Latest Software Application Releases ............................................................................................ 7 

2 System Architecture ................................................................................................................................. 8 
3 E7630A-MTP Software Installation ..................................................................................................... 9 

Installation Computer Minimum Requirements............................................................................. 9 
Downloading the Latest Version of E7630A-MTP Message Editor Software .............................. 9 
Connecting the Computer and Test Set ...................................................................................... 10 
Launch the E7630A-MTP Message Editor Software ................................................................... 10 

4 Menus for E7630A-MTP LTE Message Editor ................................................................................ 11 
The Menu Bar ................................................................................................................................ 11 

The File Menu........................................................................................................................ 11 
The Edit Menu ....................................................................................................................... 12 
The Encode Menu ................................................................................................................. 12 
The View Menu ..................................................................................................................... 12 
The Help Menu ...................................................................................................................... 13 

The Tool Bars ................................................................................................................................. 13 
5 Scenario File Overview .......................................................................................................................... 15 

Message Editor Fields that can be Overwritten by UXM Front-panel Menu Keys .................... 15 
6 Creating a New Scenario File .............................................................................................................. 21 
7 Modifying a Scenario File ..................................................................................................................... 22 

The RRC Window ........................................................................................................................... 23 
NAS Window .................................................................................................................................. 25 

NAS Message Insertion Procedure ....................................................................................... 26 
Linking a NAS Message to an RRC Message ........................................................................ 26 

Scenario Window .......................................................................................................................... 28 
Start Scenario ....................................................................................................................... 28 
Communication Scenario ...................................................................................................... 28 

Extended Window ......................................................................................................................... 34 
Extended Message Insertion Procedure ............................................................................... 34 

File Transfer ................................................................................................................................... 35 
File Transfer Procedure ......................................................................................................... 35 

Examples of Common Changes .................................................................................................... 36 
Setting the Channel Quality Indicator (CQI) Value ............................................................... 36 
Changing the Initial DUT IP Address ..................................................................................... 39 
Rejecting an Incoming AttachRequest ................................................................................. 44 

8 Service and Support ............................................................................................................................... 50 

v 



 

Calling Keysight Technologies ...................................................................................................... 50 
Locations for Keysight Technologies .................................................................................... 51 

 

 
 

vi 
 



E7630A-MTP Message Editor 
User’s Guide 

1 Introduction 

Welcome to the E7630A-MTP Message Editor User’s Guide for the E7515A UXM Wireless Test Set 
(UXM). The purpose of this guide is to provide you with installation instructions and user information 
for the E7630A-MTP LTE Message Editor software application. For more information about the UXM 
and other UXM software products, refer to the UXM Getting Started Guide and the UXM User’s and 
Programmer’s Guide. 

Latest Documentation 
For the latest version of all documentation, please go to  
www.keysight.com/find/UXM-Manuals. 

Latest Software Application Releases 
For the latest release of all UXM related software, please go to 
http://www.keysight.com/find/softwaremanager. 
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2 System Architecture 

The E7630A-MTP LTE Message Editor software application runs on PCs using the Microsoft (MS) 
Windows 7 operating system. The E7630A-MTP is connected to the UXM via a private Ethernet 
interface to enable you to create and modify scenario files for download into the UXM. An example 
E7630A-MTP user interface is shown below. 

  

 

Figure 2-1: E7630A-MTP Message Editor 
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3 E7630A-MTP Software Installation 

Installation Computer Minimum Requirements 
For successful operation, the installation computer for the E7630A-MTP LTE Message Editor must 
meet or exceed the following specifications: 
 

Minimum System Requirements 
Operating System Computer running Windows 7 
Communication with Test Set(s) Ethernet 
RAM (Memory) 4 GB RAM (Minimum) 
Processor >2.5 GHz Intel Pentium® Quad core or equivalent 
.NET Framework Version 4.0 or later 
 

NOTES:  
1. Consideration for storage space should be given for storing scenario files and supporting 

documentation. 
2. A clean installation of the Operating System is required to ensure freedom from Ad-ware, 

Spy-ware, updaters and other processor resource consuming applications. For expected 
performance, Antivirus software should not be running. 

3. Connecting the UXM and the message editor PC to a network is not recommended. 

Downloading the Latest Version of E7630A-MTP Message Editor 
Software 

To ensure you have the latest version, download the E7630A-MTP software from the Keysight 
software manager web site. On the www.keysight.com/find/softwaremanager download site, 
locate the E7630A-MTP Message Editor Software, and save it to a location on your PC.  
Locate the file on your PC and double-click the setup file to install the software. Follow the on-
screen instructions to complete the installation. 
 

 

Always check the release notes for the latest information about any 
known issues and other important information about your product. 
Release notes are available for download from 
www.keysight.com/find/softwaremanager. 
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Connecting the Computer and Test Set 
Connect the E7630A-MTP LTE Message Editor installation computer to the LAN port on the 
E7515A UXM rear panel. 
 

  
Figure 3-1: System Configuration 

Launch the E7630A-MTP Message Editor Software 
Start the E7630A-MTP LTE Message Editor application from the Windows Start menu by selecting 
Start, All Programs, Keysight UXM, E7630A-MTP Message Editor, E7630A-MTP. 
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4 Menus for E7630A-MTP LTE Message Editor 

The E7630A-MTP Message Editor is presented in a single window. Some functions are available 
from the menu bar. Frequently used functions are duplicated in the tool bar. 

The Menu Bar 

 
There are six drop-down menus: File, Edit, Encode, View, Window, and Help. Before any files have 
been opened, only two menus are displayed: File and Help. 
Using your mouse to select the following menu options performs the described task: 

The File Menu 
The E7630A-MTP Message Editor works with a file type known as a scenario file which contains 
message definitions and defines the desired sequence of messages exchanged between the UXM 
and a UE. These file types have an .LBMF file extension.  
 

 
 

Top Level  
Menu Option 

Drop-Down 
Menu Options 

Task Performed 

File  Opens the Drop-Down Menu 
 New… Creates a new scenario file. 
 Open… Opens an existing scenario file. 
 Close Closes the active scenario file. 
 Save Saves the active scenario file. 
 Save All Saves all open scenario files. 
 Save As Save a scenario file with a different 

name or location. 
 Search Enables you to search for text phrases 

or terms within a scenario file. 
 File Transfer… • Downloads a scenario file to the UXM. 

• Uploads a scenario file from the UXM. 
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 Print Selects the file for printing. 
File (Continued) File, Print Prints selected scenario file. 

 Tree Print Print an individual message. 
 File Preview Provides a preview of the selected scenario file. 
 Tree Preview Prints a preview of the individual 

message. 
 Exit Closes the application. 

The Edit Menu 
 

 
 

Top Level 
Menu Option 

Drop-Down  
Menu Command 

Task Performed 

Edit   
 Insert Message Inserts a new RRC or NAS 

Message into the scenario file. 
 Delete All Deletes All RRC or NAS 

Messages from a scenario file. 
 Delete Selected 

Message 
Deletes a selected RRC or NAS 
Message from a scenario file. 

The Encode Menu 
 

 
 

Top Level  
Menu Option 

Drop-Down 
Menu Command 

Task Performed 

     Encode   
 Encode All Encodes all RRC or NAS 

Messages in a scenario file. 
 Encode Selected Message Encodes a selected RRC or 

NAS Message. 

The View Menu 
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Top Level  
Menu Option 

Drop-Down  
Menu Command 

Task Performed 

View   
 RRC Editor Displays the RRC Editor window. 
 NAS Editor Displays the NAS Editor window. 
 Scenario Editor Displays the Scenario Editor 

window. 
 Extended Editor Displays the Extended Editor 

window. 
 Properties Displays the properties of the 

.LBMF file. 
• File Name 

• File Path 

• Spec Version 

• RRC Version 

• NAS Version 

• Description 

 

The Help Menu 
 

 

• Click About… to display the About (Version Information) Window. 

The Tool Bars 
The Message Editor Tool bar provides quick access to frequently used functions. 
 

 

• The  icon duplicates the function of File, New (Ctrl+N). 

• The  icon duplicates the function of File, Open (Ctrl+O). 

• The  icon duplicates the function of File, Save (Ctrl+S). 

• The  icon duplicates the function of File, File Transfer (Ctrl+S). 

• The  icon duplicates the function of View, LTE BSE ME, NAS Editor, Scenario 
Editor, Extended Editor 

• The  icon enables the function of Search. 

• The  icon duplicates the function of View, Properties. 
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The Scenario File Tool bar provides quick access to frequently used functions. 
 

  

• The  icon duplicates the function of File, New (Ctrl+N). 

• The  icon displays the Hex viewer window. 

• The  icon changes Sorting Type. 

• The  icon expands All Message List. 

• The icon duplicates the function of Encode, Encode Selected Message. 

• The  icon expands All Message List in RRC Message window. 

• The  icon duplicates the function of File, Print. 

• The  icon duplicates the function of Encode, Encode Selected Message. 

• The  icon edits Value in RRC Message window. 
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5 Scenario File Overview 

The E7630A-MTP LTE Message Editor provides the ability to create and modify a type of file known 
as a scenario file. Scenario files contain message definitions and a desired sequence of message 
exchanges at the RRC level between the UXM and a UE. Since many RRC messages also contain 
NAS messages, the E7630A-MTP also enables the creation of NAS messages. These can be 
included as payload in the generated RRC messages.  
The content of the RRC messages also determines lower layer behaviour. For example, the 
Bandwidth of the cell is defined using the dl-Bandwidth parameter in the Master Information Block. 
Scenario files are downloaded to the UXM via the E7630A-MTP LTE Message Editor, where they are 
then selected to run from a menu on the UXM. 

Message Editor Fields that can be Overwritten by UXM Front-panel Menu 
Keys 

When a scenario file is loaded on the UXM, the parameters from the scenario file that have UXM 
menu keys associated with them are updated on the UXM to reflect the values from the scenario 
file. The table below shows those values from the scenario file that can be changed using the UXM 
front-panel menu keys without requiring modification of the scenario file using the E7630A-MTP 
LTE Message Editor. 
 

Message Editor Field UXM Menu Key Key Path 

freqBandIndicator controls which 
frequency band is transmitted in 
System Information Block 1(SIB1). 

Band Cell > Config 

PA is one of the parameters that 
control the power boosting applied 
to the PDSCH. It is signaled in the 
RRC Connection Setup message. 

PDSCH PA Power > Boosting  

PB is one of the parameters that 
control the power boosting applied 
to the PDSCH. It is signaled in the 
System Information Block 2 
message. 

PDSCH PB  Power > Boosting  

dl-Bandwidth determines the 
channel bandwidth defined in the 
Master Information Block (MIB) 
message.  

DL Bandwidth Cell > Config 

Max-HARQ-Tx controls the number 
of times an UL-SCH transmission is 
transmitted if it does not receive an 
ACK. (This parameter appears in the 
RRC Connection Setup message of 
the scenario file.) 

Uplink Max HARQ 
Transmissions 

MAC/RLC/PDCP > HARQ 
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Message Editor Field UXM Menu Key Key Path 

transmissionMode controls the 
transmission mode assigned in the 
RRC Connection Setup message. If 
this value is set to TM3 or TM4, the 
codebook subset restriction field is 
also enabled. 

Transmission Mode Scheduling > Subframes 
Configuration 

p-Max is carried in SIB1 and 
provides a value for the maximum 
power the UE is allowed to transmit. 
If this value is not present in the 
scenario file, the p-Max On/Off 
setting is overwritten, but this 
setting is not. 

p-Max Power > Power Control  

p-Max On/Off determines whether 
the p-Max value is present in the 
scenario file by controlling whether 
the Information Element (IE) is 
present or not. 

p-Max On/Off Power > Power Control  

p0-NominalPUSCH contributes 
towards the power of the PUSCH 
and is carried in SIB2. 

p0-NominalPUSCH Power > Power Control  

p0-UE-PUSCH contributes towards 
PUSCH power and is carried in the 
(RRC Connection) Setup message. 

p0-UE-PUSCH Power > Power Control  

defaultPagingCycle controls how 
frequently the UE can be paged and 
is contained in SIB2. 

Default Paging Cycle Function > Paging  

nB controls how frequently the UE 
can be paged and is contained in 
SIB2. 

NB Function > Paging  

additionalSpectrumEmission 
controls how much leakage the UE 
is allowed into adjacent frequencies 
and is contained in SIB2. 

Additional Spectrum 
Emission Power > Power Control  

PDNAddressInformation is the IP 
Address assigned to the UE in the 
Activate Default EPS Bearer Context 
Request message. 
Since this is #1, it is the IP address 
that is contained inside the (Non-
Access Stratum) NAS Attach Accept 
message. 

IP Address Type RRC/NAS > EPS Bearer 
Config  

drx-Config determines if the DRX 
Config IE in the RRC Connection 
Reconfiguration message is set to 
setup or release. 

Connected Mode  
DRX  

MAC/RLC/PDCP > 
Connected Mode DRX  
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Message Editor Field UXM Menu Key Key Path 

longDRX-Cycle is related to 
Connected Mode DRX and is present 
in the RRC Connection 
Reconfiguration message. 

Long DRX Cycle 
Length  

MAC/RLC/PDCP > 
Connected Mode DRX  

longDRX-CycleStartOffset is present 
in the RRC Connection 
Reconfiguration message. 

DRX Start Offset MAC/RLC/PDCP > 
Connected Mode DRX  

onDurationTimer is related to 
Connected Mode DRX and is present 
in the RRC Connection 
Reconfiguration message. 

onDurationTimer MAC/RLC/PDCP > 
Connected Mode DRX  

drx-InactivityTimer is related to 
Connected Mode DRX and is present 
in the RRC Connection 
Reconfiguration message. 

drx-InactivityTimer MAC/RLC/PDCP > 
Connected Mode DRX  

shortDRX is related to Connected 
Mode DRX and is present in the RRC 
Connection Reconfiguration 
message. This field controls whether 
shortDRX IE is present or not. 

Short DRX  MAC/RLC/PDCP > 
Connected Mode DRX  

shortDRX-Cycle is related to 
Connected Mode DRX and is present 
in the RRC Connection 
Reconfiguration message. 

shortDRX-Cycle MAC/RLC/PDCP > 
Connected Mode DRX 

shortDRX-CycleTimer is related to 
Connected Mode DRX and is present 
in the RRC Connection 
Reconfiguration message. 

drxShortCycleTimer MAC/RLC/PDCP > 
Connected Mode DRX 

sr-ConfigIndex controls the 
frequency and on which subframe 
scheduling request messages can be 
sent. (This parameter appears in the 
RRC Connection Setup message of 
the scenario file.) 

Scheduling Request 
Configuration Index 

MAC/RLC/PDCP > 
General  

UL-DL Configuration, used only in 
TDD, controls how many subframes 
are used for DL transmission, how 
many for UL transmission and how 
many are special subframes (used 
for both). It appears in the SIB1, with 
the name subframeAssignment. 

TDD UL-DL 
Configuration Cell > Config  
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Message Editor Field UXM Menu Key Key Path 

Special Subframe Configuration, 
used only in TDD, controls the 
configuration of the special 
subframe – how many symbols of 
the subframe are used for downlink 
transmission and how many for 
uplink. It appears in SIB1, with the 
name specialSubframePatterns. 

TDD Special 
Subframe 
Configuration 

Cell > Config  

AS Ciphering Algorithm controls the 
Ciphering Algorithm selected for use 
in the Access Stratum. This is 
signaled in the RRC layer’s Security 
Mode Command. 

RRC Security 
Algorithm RRC/NAS > Security 

MCC is carried in SIB1.  
It also exists in the NAS Attach 
Accept message: 
• in the TAIList  
• in the Globally Unique 

Temporary Identity (GUTI), if it is 
present 

and overwrites both of these values. 

MCC Cell > Identities  

MNC is carried in SIB1.  
It also exists in the NAS Attach 
Accept message: 
• in the TAIList  
• in the Globally Unique 

Temporary Identity (GUTI), if it is 
present 

and overwrites both of 
these values. 

MNC Cell > Identities 

This setting controls the number of 
digits of MNC. It is carried in SIB1. 
It also exists in the NAS Attach 
Accept message: 
• in the TAIList  
• in the Globally Unique 

Temporary Identity (GUTI), if it is 
present 
and overwrites both of these 
values.  

MNC Length  Cell > Identities 

NAS Ciphering Algorithm controls 
the Ciphering Algorithm selected for 
use in the Non Access Stratum. This 
is signaled in the EMM layer’s 
Security Mode Command. 

NAS Security 
Algorithm RRC/NAS > Security  
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Message Editor Field UXM Menu Key Key Path 

This enables the EPS Bearer ID 
associated with each of the 
configured Default EPS Bearer 
Contexts in the scenario file to be 
read back.  

Default EPS Bearer 
Config # 1 (-4) 

RRC/NAS > EPS Bearer 
Config 

IP Address Type controls what type 
of IP address is assigned to the UE in 
the Activate Default EPS Bearer 
Context Request message. You can 
assign an IPv4 address, an IPv6 
address, or both an IPv4 and IPv6 to 
the UE. 

IP Address Type RRC/NAS > EPS Bearer 
Config 

V4 Address controls the IPv4 
address that is assigned to the UE in 
the Activate Default EPS Bearer 
Context Request message, if the IP 
Address Type selection has enabled 
this. 

IPv4 Address RRC/NAS > EPS Bearer 
Config 

V6 Address controls the IPv4 
address that is assigned to the UE in 
the Activate Default EPS Bearer 
Context Request message, if the IP 
Address Type selection has enabled 
this. 

IPv6 Address IID RRC/NAS > EPS Bearer 
Config 

DNS State controls whether a DNS 
address will be assigned to the UE in 
the Activate Default EPS Bearer 
Context Request message. 

Number of DNS 
Server Addresses 

RRC/NAS > EPS Bearer 
Config 

DNS Address Type controls what 
type of IP address (IPv4, IPv6 or 
IPv4v6) is assigned as a DNS 
address in the Activate Default EPS 
Bearer Context Request message. 

DNS Type RRC/NAS > EPS Bearer 
Config 

V4 DNS Address controls the IPv4 
address that is assigned as a DNS 
address in the Activate Default EPS 
Bearer Context Request message, if 
the DNS Address Type selection and 
DNS State have enabled this. 

IPv4DNS Address RRC/NAS > EPS Bearer 
Config 

V6 DNS Address controls the IPv6 
address that is assigned as a DNS 
address in the Activate Default EPS 
Bearer Context Request message, if 
the DNS Address Type selection and 
DNS State have enabled this. 

IPv6 DNS Address RRC/NAS > EPS Bearer 
Config 
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Message Editor Field UXM Menu Key Key Path 

APN selects the value of the APN 
that is assigned to the UE in the 
Activate Default EPS Bearer Context 
Request. Based on the APN 
Overwrite menu key, it is also used 
to overwrite the APN in the 
Communication Scenario. For more 
information, see Access Point Name 
on page 30. 

APN RRC/NAS > EPS Bearer 
Config 

APN Overwrite controls whether the 
APN is overwritten only in the 
Default EPS Bearer Context Request 
message, or whether the value also 
overwrites the APN in the 
Communication Scenario. For more 
information, see Access Point Name 
on page 30. 

UE Requested APN  RRC/NAS > EPS Bearer 
Config 

P-CSCF State controls whether the 
IP address of a Proxy-Call Session 
Control Function server is supplied 
to the UE in the Activate Default EPS 
Bearer Context Request message. 

Number of P-CSCF 
Server Addresses 

RRC/NAS > EPS Bearer 
Config 

P-CSCF Address Type controls what 
type of IP address (IPv4, IPv6 or 
IPv4v6) is assigned as the IP address 
of the P-CSCF server.  

P-CSCF Type RRC/NAS > EPS Bearer 
Config 

V4 P-CSCF Address controls the 
IPv4 address that is assigned as the 
IP address of the P-CSCF server – 
assuming the P-CSCF State has 
enabled this. 

IPv4 P-CSCF 
Address 

RRC/NAS > EPS Bearer 
Config 

V6 P-CSCF Address controls the 
IPv6 address that is assigned as the 
IP address of the P-CSCF server – 
assuming the P-CSCF State has 
enabled this. 

IPv6 P-CSCF 
Address 

RRC/NAS > EPS Bearer 
Config 

Cause Code State controls whether 
the Activate Default EPS Bearer 
Context Request message will 
contain a Cause Code (which usually 
indicates a requested service is not 
available) 
Cause Code controls the cause code 
that will be contained in the Activate 
Default EPS Bearer Context Request 
message, assuming the Cause Code 
State has enabled this. 

Cause Code 
RRC/NAS > EPS Bearer 
Config 
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6 Creating a New Scenario File 

It is often easiest to start with an existing scenario file as a template and make modifications from 
that. However, you may want to create a new scenario file to use as a completely blank canvas. 

1. Click New Insert Icon  or Click File, New 

 

 

Figure 6-1: Creating New Scenario File 

2. Click the OK button. This creates a new, blank, scenario file.  

3. Save this under an appropriate name before making further edits to it. 
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7 Modifying a Scenario File 

After you save a new scenario file or open an existing one, you see four tabs at the bottom left of the 
scenario file window, which enables you to access the various functions of the E7630A-MTP 
Message Editor. They are described in each of the sections below: 
 

• The RRC Window 

• NAS Window 

• Scenario Window 

• Scenario Window 

• Extended Window 

• File Transfer 

• Examples of Common Changes 
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The RRC Window 
The E7630A-MTP LTE message editor provides a comprehensive tool for generating and 
manipulating RRC (Radio Resource Control) messages. 

The RRC Message List box displays all the user defined RRC messages. By clicking on the Insert 
Message button, you can easily insert, delete, and edit RRC messages. You can select an 
individual message on the list to view its structure and parameters on the Message Structure box 
to the right of the RRC Message List.                  

 

Figure 7-1:RRC Message Structure 

1. Click on the Insert Message icon. The window below is displayed. 

2. Select the PDU Type (Protocol Data Unit) of message you would like to include. 

3. Double-click or drag and drop to insert it into the Insert Message window.  

4. Name the message by double-clicking in the Name column and typing the desired name. (For 
example: “Master Information Block”) 
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Figure 7-2: Insert a New Message Type 

5. A message can be created directly by inserting a hex value into the Value column or this can be 
left blank. 

6. Click the OK button. 

A new message now appears in the RRC Message List.  

 

If the message name appears in red, this indicates that it still needs to 

be encoded. To encode a message, select either of the  icons at 
the top of the new message windows. 

 
If a hex value has been specified for the message, a decoded RRC message corresponding to that 
hex value appears on the right-hand side, when the message name is highlighted. 
If the hex value has not been specified, a blank message corresponding to the selected PDU type 
appears in the right-hand side.  

 

 

Figure 7-3: New RRC Message 
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The fields of the message can be manipulated by selecting a modifiable parameter on the right-
hand side, right-clicking and selecting Change Value. Depending on the field type, a value can 
either be entered directly, or chosen from an enumerated list.  
 

 
Any applied changes to an RRC message on the list are not finalized 
unless the message is encoded again. 

 

Figure 7-4: Detail Information - Output - Hex Viewer 
 
The Input box (the top-right-side window, where you can change values) shows a brief summary of 
a selected item. Once you encode an item, the result is shown in the Output box.  

NAS Window 
Non-Access Stratum (NAS) Editor enables you to easily generate and decode encoded HEX NAS 
data. These are very important features to create a wide range of UXM scenario files. Generated, 
encoded HEX NAS data can be used in the E7630A-MTP to generate RRC messages containing 
NAS data; any received NAS messages on the eNodeB emulator side can be decoded for 
debugging. 

 

It is not sufficient to construct an NAS message for it to be included in 
a scenario file – the hex content associated with the NAS message 
must appear inside an RRC message for it to be sent to the UE during 
a message exchange. This can be easily accomplished from the RRC 
menu tab, by right-clicking on the NAS field and selecting the NAS 
message you wish to include from the drop-down list. See step #7 on 
page 46 as an example.   
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Figure 7-5: NAS Message Insert Window 
 
To generate a new message, first select one of the DL/UL radio buttons in the Message Type box.   

NAS Message Insertion Procedure 
1. Click the Insert Message icon or Edit, Insert Message. 

2. Select Message Type. 

 

3. Select Message. 

4. Double-click or drag and drop to the Insert Message window. 

5. Click OK button. 

Linking a NAS Message to an RRC Message 
Linking NAS messages to RRC messages enable you to update the NAS message parameter and 
automatically update the RRC message containing the NAS message. 
1. Select an RRC message that contains a NAS message. 

2. Right-click on the parameter you wish to change in the NAS message list. In the example 
below, RRC Reconfiguration is the RRC message that contains the dedicatedInfoNASList. As 
shown, right-clicking on SEQ 1 displays a ‘Change NAS’ choice. 
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Figure7-6: Linking ATTACH_ACCEPT to RRC Reconfiguration Message 
 
3. Selecting ‘Change NAS’ enables you to choose the NAS Message you wish to link. In this 

example, ATTACH_ACCEPT is selected. 

4. Select ‘Enter’ on your keyboard or click in any of the white areas of the software user 
interface. Notice that the value for SEQ 1 has changed.  

5. Select the encode Message icon at the top of the screen and verify the encoding was 
successful by the text shown in the Output tab section at the bottom of the display. 

6. The NAS message is now linked to the RRC message, so any changes made to the NAS 
message can be automatically updated in the RRC message if you choose. Refer to a 
continuation of this example in Changing the Initial DUT IP Address on page 39. 
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Scenario Window 
The Scenario Editor provides a simple interface for you to create and modify various test 
scenarios for the eNodeB emulator. Use the DL RRC messages (which may contain NAS data) 
defined in E7630A-MTP LTE Message Editor software as well as those you have pre-defined. Each 
scenario is divided into two sub-scenarios:  

• Start Scenario 

• Communication Scenario 

Start Scenario 
The Start Scenario window defines master information block and system information block 
messages that are broadcast by the UXM; you can double-click or drag and drop to place a 
selected MIB/SIB message in Start Scenario box. The index in the Start Scenario box indicates the 
order of message transmission from eNodeB. You can define three sets of SI messages with 
different numbers or types. 

 
Figure 7-7: Start Scenario Window 

Communication Scenario 
The Communication Scenario window defines the desired message exchange between the UXM 
and a UE. The UL RRC Message contains the name of a standard RRC Message (for example, 
rrcConnectionRequest). The right-hand DL RRC Message column contains the name of the 
message that is sent to the UE as a result of receiving the UL RRC Message Type. The messages 
in the DL RRC column are those that have been constructed by the user and appear in the RRC 
Window. 

Some UL RRC messages can carry NAS messages inside them. For those messages, it is possible 
to further qualify the DL RRC message that are sent based on the NAS content of an UL RRC 
message. So, for a received UL Information Transfer message at RRC, different DL RRC messages 
could be sent to the UE depending on the NAS message that was carried inside the UL RRC 
Message. 
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Figure7-8: Communication Scenario Window 
 
There are ten tabs in the Communication Scenario window: 

• RRC_CONNECTION (Initial Attach) – This tab shows those messages and events related to 
the initial attach. 

• RRC_CONNECTION_1 (Service Request) – This tab shows those messages and events 
related to the UE requesting service. 

• RRC_CONNECTION_2 (TAU Request) – This tab shows those messages and events related 
to a Tracking Area Update (TAU), required when performing handovers as it updates the 
UE location to the enodeB. 

• RRC_CONNECTION_3 (Ext Service Request) – This tab shows those messages and events 
related to an extended service request.  

• RRC_CONNECTION_4 (Detach Request) – This tab shows those messages and events 
related to a detach request.  

• RRC_CONNECTION_5-9 – These tabs store information inside the ASCII file generated by 
E7630A-MTP Message Editor in the same way the content from the other tabs is stored. 
You can switch to these tabs after sending a message by selecting from Goto Next Tab or 
manually select the tabs to use by sending an RUI command. 

You can change the NAS message from this view by double-clicking the message and then making 
your selection from a drop-down list, as shown below. 
 

  

Figure 7-9: Changing NAS Messages 
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Figure 7-10: Qualifying Message Response to UL NAS Message  
 

As well as qualifying a message response based on the UL NAS message that is being carried, 
there is the option to further qualify the response to certain messages based on message content. 
 

Access Point Name 
 
The PDN Connectivity Request message can carry information on the Access Point Name. It is 
possible to determine the response needed to be sent, based on the Access Point Name carried 
inside the message. This means that different responses can be sent in response to different PDN 
Connectivity Request messages. 
The UXM front-panel menu-key, UE Requested APN, represents the Access Point Name that the 
UE is requesting a connection to in the PDN Connectivity Request. 
 

 

Figure 7-11: Different Responses Available to PDN Connectivity Request Message 
 
The PDN Disconnect Request message specifies an EPS Bearer Identity associated with the PDN 
that the UE is requesting to disconnect from. Specifying a value in the Linked EPS Bearer ID field 
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enables precise specification of the Deactivate EPS Bearer Context Request message that the UXM 
should send to the UE. 
 

 

Figure 7-12: Specifying a Value in the Linked EPS Bearer ID Field 
 
The Bearer Resource Allocation Request is a request from the UE that a Dedicated Bearer is 
established. The message can include different EPS Bearer Identities and different QCI values 
inside it. The Linked EPS Bearer Identity represents the Default Bearer with which the UE would 
like the Dedicated Bearer to be associated. The QCI value corresponds to the requested quality of 
the Dedicated Bearer. This provides the flexibility of choosing different DL RRC Messages that can 
be sent in response to combinations of these two parameters. These different messages can 
activate different Dedicated EPS Bearer Contexts. 
 

 

Figure 7-13: Selecting Default EPS Bearer IDs and QCI Values 
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The ESM Information Request is a request from the UE that the APN information is transferred 
after the NAS Security Mode procedure is completed. You can perform the ESM Information 
Request/Response procedure by checking the ESM Information Transfer Request in PDN 
Connectivity Request? box,  
 

  
 

Figure 7-14: Selecting ESM Information Transfer Request in PDN Connectivity Request? 
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Measurement Report  
 
The Measurement Report message can carry a different measurement identity (or MeasID). A 
different response can be sent to measurement reports containing different measurement 
identities – allowing a certain report to trigger an automatic redirection to another cell, for 
example. 
 

 

Figure 7-15: Different Measurement Identity Available for Message Report Message 
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Extended Window 
Using Extended Window, you can add a message that has been defined in the RRC message 
window to the Custom Message, Page Message, Release Message, or Handover Message pane. 
 

 

Figure 7-16: Extended Window 

Extended Message Insertion Procedure  
1. Select a message in the All Message View. 

2. Select message and click the  icon (All/Custom/Release/Paging/Handover.) 
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File Transfer 
A scenario file must be transferred to the UXM before it can be run. This is done using the 
procedure below.  

File Transfer Procedure 

1. Click  icon from the main tool bar or select File, File Transfer. 

  

2. Check the IP Address (for example: 192.168.1.60).  

  

3. Click Connect Button. 

4. Click the check box from the File Name list. 

5. Click  icon  

6. The file is transferred to the scenario file directory 
D:\ProgramData\Keysight\E7515A\E7530A_E7630A\Scenario Files\User 

in the UXM. A message indicates whether the message has been successfully transferred. 

7. On the UXM, select Call Scenario > Load to see the list of available scenario files, and 
check that the file you downloaded is listed.   

 

Figure 7-17: Verifying a Successful Download 
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Examples of Common Changes 

Setting the Channel Quality Indicator (CQI) Value 
1. Locate the rrcConnectionSetup message on the RRC message tab. The cqi-ReportConfig 

Information Element is near the bottom of this message.  

 

Figure 7-18: Accessing CQI Reporting 

2. The Information Element (IE) may not be present in the message – which indicates to the 

UE that CQI reporting is not being configured in this message. To include the IE, highlight 

the cqi-ReportingConfig field as shown above and notice that an IE Addition box becomes 

available under the Detail Information tab. Select the box marked IE Addition. This enables 

the cqi-ReportConfig information to become visible as shown below. 
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Figure 7-19: Enabling CQI Report Configuration 

3. Disable Aperiodic CQI reporting, by highlighting the cqi-ReportModeAperiodic field and de-

selecting the IE Addition box. 

 

Figure 7- 20: Disabling Aperiodic CQI Reporting 

4. Enable Periodic CQI reporting, by right-clicking the cqi-ReportPeriodic IE and selecting 

‘setup’ from the drop-down list of possible options.  
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Figure 7-21: Enabling Periodic CQI Reporting 

5. The most basic type of CQI reporting is Periodic Wideband CQI reporting. Setting the values 

shown in the diagram below enable this.  

 

Figure 7-22: Settings for Periodic Wideband CQI Reporting 

6. Make sure you encode the message by clicking the encode Message button. The Setup 

message in the RRC Message List changes its color, from red to black, indicating the 

message is encoded. 

 
If you navigate away from the message before pressing the encode 
Message button, your changes are lost. 

 

7. Select File, Save As... , and save the file with a new name, retaining the .LBMF extension. 
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Changing the Initial DUT IP Address 
In this example, you will change the Initial DUT IP Address in the 
ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST message and automatically update the 
RRC Reconfiguration message with this new value. 

1. You should already have an ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST 
message in your NAS Message List. If not, refer to the “NAS Message Insertion Procedure” 
on page 26 to include one.  

2. If you have not already done so, use the “Linking a NAS Message to an RRC Message” on 
page 26 to link the ATTACH_ACCEPT message to the RRC Reconfiguration message. 

 

It is best to link NAS messages to the RRC messages because this 
enables all NAS message value changes to be automatically updated 
in the RRC messages to which they are linked. 

 
For this example we are also going to link the 
ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST NAS message to the ATTACH_ACCEPT 
message.  

3. On the NAS window tab, select the ATTACH_ACCEPT message. Notice the 
ESMMessageContainer parameter in the Input window on the right-hand side. 

4. Right-click on NasMessageDnData and select ‘Change NAS ESM’.  

 

Figure 7-23: Settings for Periodic Wideband CQI Reporting 

5. Select the ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST message.  

6. Encode the new NAS ESM message by selecting the encode Message icon at the top of the 
window. The following information message pops-up:  
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Figure 7-24: Applying NAS Message Update to RRC Message 
 

 

If you do not see the above message, then this NAS message is not 
linked to any RRC message and you will have to go back to the RRC 
window and perform the linking procedure as described above or copy 
and paste the hex values as required in previous versions of E7630A-
MTP Message Editor software. 

7. Select ‘Yes’ because you want this new value to be applied in the RRC message. Notice the 
“Encode Success” message is now displayed in the Output tab window. You now have 
linked the ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST NAS message to the 
ATTACH_ACCEPT message, so any changes to either of these messages are reflected in the 
RRC Reconfiguration message. 

8. Right-click the PDNAddressInformation entry and select ‘Value Change’ when it pops up. 
The IP address field is now available to be changed.  

 

Figure 7-25: Changing the IP Address 

9. Enter the new IP address you wish to use.  

10. Encode the new IP address by selecting the encode Message icon at the top of the window. 
The following information message pops-up: 
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11. Select ‘Yes’ because you want this new value to be applied in the RRC message. Notice the 
“Encode Success” message is displayed in the Output tab window. 

12. Go to the RRC window and notice the RRC Reconfiguration message has turned red. When 
you select this RRC message you can see that the value for SEQ 1 has changed. Select the 
encode Message icon. The Output tab window now displays “Message is Encoded!”. The 
RRC Reconfiguration message is now black, which also verifies encoding is successful. 

 
Signaling Other Addressing Options 

 
The ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST message is also the method for 
signaling other addressing options.  

• Right-clicking on the message header displays a list of these options.  

• Left-clicking on each of these options adds additional fields to the message.  

It is possible to enter a list of separate addressing options within a single message. In the example 
below, ContainerCfgs is set to 3, enabling you to provide 3 addresses to the UE when the 
ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST message is transmitted to the UE. This 
example sets one P-CSCF and two DNS addresses.  
 

 

Figure 7-26: DUT IP Address Additional Information Options 

1. Select the ProtocolConfigurationOptions line. Right-click on ContainerCfgs and change the 
content to 3. 

 

Figure 7-27: Creating ContainerIds for IP Addresses 
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Figure 7-28: DUT IP Address Additional Information Options 

2. Right-click on ContainerId, select “Value Change” and then access the additional information 
element options shown in figure 7-26 by selecting the drop-down list.  

3. Use the three containerId fields to select and populate each address for the information 
elements:  

• P-CSCF IPv6 Address 

• DNS Server IPv4 Address 

• DNS Server IPv6 Address 

 
The resulting contents are shown in figure 7-29. 
. 

 

The UE IP address is entered in the form 021F:29FF:FE7C:8F51.  
The server addresses also include the header information (resulting 
in 32 characters), and the colon separators must be omitted.  
The UE IPv4 address is entered in dot separated decimal. 
The server IPv4 addresses are entered in HEX with no separators.  
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Figure 7-29: DUT IP Address Additional Information Options Final Content 

4. Make sure you encode the message by clicking the encode Message button.  

 
If you navigate away from the message before pressing the encode 
Message button, your changes will be lost. 

 
The following information message pops-up: 
 

 

5. Select ‘Yes’ because you want this new value to be applied in the RRC message. Notice the 
“Encode Success” message is displayed in the Output tab window. 

6. Go to the RRC window and notice the RRC Reconfiguration message has turned red. When you 
select this RRC message you can see that the value for SEQ 1 has changed. Select the encode 
Message icon. The Output tab window now displays “Message is Encoded!” The RRC 
Reconfiguration message is now black, which also verifies encoding is successful. 
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Rejecting an Incoming AttachRequest 
The basic steps to complete this process are as follows. If you already know how to do any of the 
steps, they can be skipped and you can focus only on those for which you need help. 
 

• Creating a New NAS Message 
• Creating a New RRC Message 
• Wrapping it in an RRC Message 
• Modifying Communication Scenario response to incoming AttachRequest 

 
Creating a New NAS Message 

1. Create a new NAS message by following the NAS Message Insertion Procedure on page 26.  

2. Select ATTACH_REJECT from the Type Name list, and drag it over to the Insert message 

area. 

3. Click OK. Notice that the new message is added to the NAS Message List. 

 

Figure 7-30: Creating New NAS Message 
 

Creating a New RRC Message 

1. Select the RRC tab. 

2. Then add a new RRC message by selecting the Insert Message icon or Edit, Insert 

Message. 

3. Select message type as DL-DCCH-Message. 

4. Drag it to the Insert Message area. 

5. Double-click the Name field and rename it to, Attach_Reject. 
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Figure 7-31: Inserting New RRC Message 

6. Click OK. Notice that the new message is added to the RRC Message List. 

 
 

Wrapping it in an RRC Message 

1. Select the new Attach_Reject message. 

2. Note that the generic properties of the message you created is csfb to CDMA2000… This 

must be replaced.  

3. Right-click in the c1 field. Select ‘Type Choice’ when it pops up.  

4. From the drop-down list, select dlInformation Transfer. 
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Figure 7-32: Selecting Message Properties as dlInformation Transfer 

5. Select the nonCriticalExtension field. Then de-select the IE Addition box (at the foot of the 

screen) – this removes it from the message. 

 

Figure 7-33: De-selecting IE Addition 

6. Right-click the dedicatedInfoNAS field and select ‘Change NAS’. 

7. Select the Attach_Reject NAS message from the drop-down list. 
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Figure 7-34: Selecting ATTACH_REJECT NAS Message 

8. Notice that the RRC name of Attach_Reject has turned red in the left hand RRC Message 

List column. This indicates that you have edited the contents of this RRC message and you 

must now encode the message. (If you don’t encode the message now, you will lose your 

changes.) 

9. Select the encode Message button at the top of the window to encode the message. Verify 

that the RRC Attach_Reject message name has turned from red to black (left-hand 

window) and that the Output tab text at the bottom of the right-hand window states 

success. These both indicate that your encoding was successful. 

 

Figure 7-35: Verifying Successful Message Encoding 

10. Now save the modified scenario file and transfer it to your UXM. 
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Modifying Communication Scenario response to incoming AttachRequest 
 
These steps below modify the scenario file to send an Attach_Reject in response to an 
Attach_Request. 

1. Click on the Scenario tab 

2. From the Communication Scenario area select the ‘RRC_Connection (Initial Attach)’ 

3. Locate the transaction containing the incoming ATTACH_REQUEST. (In this example the 

UXM has been set to respond with a DL Authentication message. That must be replaced 

with the Attach_Reject message that was created above.) 

4. Double-click on the transaction containing the ATTACH_REQUEST (a message editing 

window will pop up) 

 

Figure 7-36: Modifying Response to Incoming AttachRequest 

5. From the DL RRC MESSAGE drop-down list select Attach_Reject 

6. Click OK. 

7. The transaction should now show Attach_Reject in response to the ATTACH_REQUEST. 

48 
 



E7630A-MTP Message Editor 
User’s Guide 

 

Figure 7-37: Saving Attach_Reject Response to Incoming AttachRequest 

8. Now save the scenario and transfer it to your UXM. 
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8 Service and Support 

Calling Keysight Technologies 
Keysight Technologies has offices around the world to provide you with complete support for your 
products. For help, to obtain servicing information or to order replacement parts, contact the 
nearest Keysight Technologies office listed below. In any correspondence or telephone 
conversations, you will need the product number, full serial number, and software revision details. 
Press the System>App Info front panel key to view the product number (E7515A), serial number, 
and software revision information.  
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Locations for Keysight Technologies 
Online assistance: http://www.keysight.com/find/assist 
If you do not have access to the Internet, one of these centers can direct you to your nearest 
representative: 
Should the Declaration of Conformity be required, please contact a Keysight Sales Representative, 
or the closest Keysight Sales Office. Alternately, contact Keysight at: www.keysight.com. 
 

Americas   
Brazil   
55 11 3351 7010 

Canada  
(877) 894 4414 

Mexico  
001 800 254 2440 

United States  
(800) 829 4444 

  

 
Asia Pacific   
Australia  
1 800 629 485 

India  
1 800 112 929 

    Malaysia  
    1 800 888 848 

China  
800 810 0189 

Japan  
0120 (421) 345 

    Singapore  
    1 800 375 8100 

Hong Kong  
800 938 693 

Korea  
080 769 0800 

    Taiwan  
    0800 047 866 

Other Asian Countries: 
(65) 6375 8100 
www.keysight.com/find/contactus 

  

 
Europe & Middle East   
Austria  
0800 00 11 22 
Belgium 
0800 58 580 
Finland 
0800 523 252 
France  
0805 980 333 
*0.125 €/minute 

        Germany 
0800 6270 999 

Ireland  
1800 832 700 
Israel 
1 809 343 051 
Italy  
800 599 100 
Luxembourg 
+32 800 58580 
Netherlands  
0800 0233 200 

Russia 
8800 5009 286 
Spain  

    0800 00 01 54 
Sweden  

    0200 88 22 55 
Switzerland  

    0800 80 53 53 
United Kingdom  

    0800 0260 637 

Other Unlisted Countries: 
www.keysight.com/find/contactus 
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